Studio 5

Opcode Systems, Inc.
365 East Middlefield Road
Mountain View, CA 94043
(650) 429-2400
http://www.opcode.com

Opcode Part Number: 110-0214-02

Copyright ©1997 Opcode Systems, Inc. All rights reserved. This document may not, in whole or
part, be copied, photocopied, reproduced, translated or converted to any electronic or machine
readable form without prior consent of Opcode Systems, Inc.

LIMITED WARRANTY

WARNING

Opcode Systems, Inc. warrants the Studio 5 against defects in materials and workmanship for a period of one (1) year from the date of original retail purchase.

NOTE: This equipment has been type tested and found to comply with the limits for
a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in residential installations. This equipment uses, and can radiate radio frequency energy, and
if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If you discover a defect, first write or call Opcode Systems, Inc. at (650) 856-3333 to
obtain a Return Merchandise Authorization Number (no service will be performed
on any product returned without prior authorization). If the product needs to be
returned to Opcode, please attach your name, address, telephone number, a description of the problem, and a copy of the dated bill of sale as proof of purchase. Write
the Return Merchandise Authorization (RMA) Number clearly on the outside of the
package and all correspondence. Upon receiving the returned product, Opcode Systems, Inc. will then, at its option, repair, replace, or refund the purchase price of the
product.

If this equipment does cause interference to radio or television equipment reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna

This warranty applies only to the Studio 5; Opcode software is warranted separately.
• Move the equipment away from the receiver
This warranty does not apply if the product has been damaged by accident, abuse,
misuse, or misapplication, or has been modified without the written permission of
Opcode Systems, Inc.
All implied warranties, including implied warranties of merchantability and fitness
for a particular purpose, are limited in duration to one (1) year from the original date
of retail purchase of this product. The warranty and remedies set forth above are
exclusive and in lieu of all others, oral or written, express or implied.
Opcode Systems, Inc. is not responsible for special, incidental, or consequential
damages resulting from any breach of warranty, or under any legal theory, including
lost profits, downtime, good-will, damage to or replacement of equipment and
property.
Some states do not allow the exclusion or limitation of implied warranties or liability
for incidental or consequential damages, so the above limitation or exclusion may
not apply to you. This warranty gives you specific legal rights, and you may also
have other rights which vary from state to state.
Except to the extent prohibited by law, all implied warranties made by Opcode Systems, Inc. in connection with this manual and software are limited in duration to
ninety (90) days from the date of original purchase, and no warranties, whether
express or implied, shall apply to this product after said period.
Opcode Systems, Inc. makes no warranty or representation, either express or
implied, with respect to the software described in this manual. This software is sold
“as is.” The purchaser assumes the entire risk as to its quality and performance.
Under no circumstances shall Opcode Systems, Inc. be liable for any loss or damage, direct, consequential, or incidental, arising out of the use or inability to use this
product.
Some states do not allow limitations on how long an implied warranty lasts or the
exclusion or limitation of incidental or consequential damages, so the above limitations or exclusions may not apply to you.

• Plug the equipment into an outlet on a circuit different from that to which the
receiver is powered.
If necessary, the user should consult the dealer or an experienced radio/television
technician for additional suggestions.
CAUTION: Only equipment certified to comply with Class B (computer input/output
devices, terminals, printers, etc.) should be attached to this equipment, and must have
shielded interface cables.
Finally, any changes or modifications to the equipment by the user not expressly
approved by the grantee or manufacturer could void the users authority to operate
such equipment.
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CHAPTER 1:

Getting Started

OVERVIEW OF THE STUDIO 5

•

Opcode’s Studio 5LX (hereafter referred
to as “Studio 5”) is a multi-port Macintosh
MIDI interface and patchbay with a builtin SMPTE time code generator and
SMPTE-to-MIDI Time Code converter.

•

MIDI features of the Studio 5 include:

•

•

•

•

•

•
•

Fifteen independently addressable
MIDI inputs and outputs—this allows
access to 240 separate MIDI channels
with programs that support either
OMS or Mark of the Unicorn’s MIDI
Time Piece™;
OMS Studio Patches support—the
Studio 5 has a built-in 16MHz 68000
microprocessor for processing Studio
Patches. Studio Patches allow MIDI
data to be split, transposed, modified
and mapped in many useful ways;
Storage for up to 128 OMS Studio
Patches—the Studio 5 has 256K of
RAM for storing Studio Patches;
Networking—connect up to six
Studio 5’s for 1,440 separate MIDI
channels;
Standard (1MHz) and Fast communication speeds;
Emulates either a standard MIDI
interface or a MIDI Time Piece;
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•

A pair of MIDI activity indicators for
each MIDI port;
Patch number display and program
change buttons;
Front panel MIDI/Thru switches—
these let you use external peripherals
(such as printers or modems) without
changing cables;
Two assignable footswitch inputs and
a foot controller input.

Sync functions of the Studio 5 include:
•
•
•
•
•

•

SMPTE time code generation (five
frame rates);
SMPTE-to-MIDI Time Code
conversion;
SMPTE-to-Direct Time Lock conversion (both DTL and DTLe);
Jam Syncing (rewrites fresh SMPTE
when locked);
Freewheeling (remains locked
despite dropouts or other short
SMPTE errors);
Audio input to create a MIDI trigger.

The Studio 5 uses the Open Music
System (OMS) and the Studio 5 OMS
driver software to configure all MIDI and
sync functions.

1

ABOUT THIS MANUAL

THE STUDIO 5 PACKAGE

This manual does not attempt to teach
fully the fundamentals of MIDI or SMPTE
sync operations. A brief SMPTE overview
is offered at the end of this chapter, but if
you’re new to either of these standards,
you should read magazines specializing in
music technology, or purchase basic
MIDI and SMPTE books from your local
bookstore or music dealer.

Your Studio 5 package contains the
Studio 5, two serial cables, one power
cable, a mounting kit (consisting of 2 rack
ears, 6 screws, and 4 rubber feet), OMS
and Studio 5 software, an OMS manual, a
Studio Patches manual, this Studio 5 manual, and your registration card.

Also, you should be familiar with basic
Macintosh operations. If you’re not,
please read the Macintosh manual before
using the Studio 5.

CUSTOMER SUPPORT AND
REGISTRATION

This manual discusses how to connect,
set up and use the Studio 5—it describes
Studio 5 operations at the time of its printing. However, updates and changes may
occur. Always look for hardware and software update information in the Read Me
files installed onto your hard disk.
OMS Studio Patches are discussed in the
Studio Patches manual. You should read
this manual after setting up your Studio 5.
The Studio 5 uses the Open Music
System (OMS) and the Studio 5 OMS
driver software to program all mapping,
channelizing, routing and sync functions.
If you’re already familiar with OMS, you
can read this manual straight through.
NOTE: If you are unfamiliar with OMS,
read the first three chapters in this manual,
then read the OMS manual before continuing with Chapter 4: Software Setup.
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Registering your Studio 5
Please complete and return your registration card right away. Doing so will enable
Opcode to deliver the best possible support to you; it also insures you’ll receive
important update/upgrade notices.
IMPORTANT: Please write down your
Studio 5 serial number here. The serial
number is on the back of the Studio 5 by the
power connector.
S/N _______________________________
Purchase Date ______________________
Contacting Opcode
Opcode provides a variety of phone, fax,
and online support options. Consult your
Technical Support Information booklet on
how best to contact Opcode.

Opcode Systems, Inc.
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SYNC BASICS
The operational portions of this manual
assume you’re familiar with SMPTE time
code, MIDI Time Code, and Direct Time
Lock. If you’re not, you should read this
section to develop a basic understanding
of synchronization and the various time
code formats. Consult music technology
magazines or introductory books if you
need more information about any of these
topics.

SMPTE Time Code
SMPTE is a timing reference signal developed by the Society of Motion Pictures
and Television Engineers. It specifies a
format for recording digital timing information onto magnetic tape. Originally
designed for keeping film and video in
sync with audio, it is now commonly used
in a variety of audio specific applications.
Using SMPTE requires two separate
actions:
•

•

Generating the SMPTE time code
and recording it onto tape (a process
often referred to as “striping”).
Reading the SMPTE time code off the
tape and using it as a master timing
source for synchronizing playback of
other tape machines and computers.

There are two types of SMPTE time code:
Longitudinal Time Code (LTC), and Vertical Interval Time Code (VITC). LTC is
recorded on tape tracks that run linearly
across the length of the tape. This format
is recorded on audio tape or on the audio
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track of a video tape. VITC is recorded
within the video portion of a video tape.
The Studio 5 will both generate and read
SMPTE time code using the LTC format.
If you have a tape striped with VITC,
you’ll need to use a VITC-to-LTC converter or a VITC-to-MTC converter.
Since different video systems run at different speeds (or “frame rates”), the SMPTE
format also specifies a number of different
rates. The Studio 5 supports five SMPTE
format/frame rates (hereafter referred to
as simply “frame rates”). These frame
rates are as follows:
•
•
•

•

•

24 Frames/second—Film frame rate.
25 Frames/second—EBU (European) television frame rate.
29.97 Drop Frame—NTSC (North
American) color television frame rate.
This format runs at 30 Frames/second, but drops the first two frames
every minute, except at minutes 0, 10,
20, 30, 40, and 50.
29.97 Frames/second (Non-Drop)—
Used to sync to NTSC color television
without dropping frames. SMPTE
time does not match real time, but
playback pitch is unaffected.
30 Frames/second (Non-Drop)—
Original NTSC black and white television standard. Often used in audioonly situations since there are no
dropped frames and the SMPTE time
is equal to real time.
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MIDI Time Code and Direct Time
Lock
MIDI computer software cannot read
SMPTE time code directly off tape, so the
code must be converted into a format that
the computer can understand. This
format is called MIDI Time Code (MTC).
The converter then sends MTC (which
retains SMPTE’s hour/minute/second/
frame timing information) to the computer to control the playback of MIDI
sequencers. You use MTC to synchronize
your computer sequence to a master
SMPTE timing source.
Direct Time Lock (DTL) and Enhanced
Direct Time Lock (DTLe) are alternate
MIDI synchronization formats developed
by Mark of the Unicorn for their Performer sequencer. Very old versions of
Performer require DTL to sync to tape.
New versions of Performer use DTLe,
which provides synchronization accuracy
equal to MIDI Time Code.
The Studio 5 can convert SMPTE time
code (recorded at one of the five supported frame rates) to either MTC or one
of the Direct Time Lock formats.

Figure 1.1: blah blah blah
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more of the Studio 5’s fifteen MIDI OUT
ports.

THE STUDIO 5 FRONT PANEL
Studio 5
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Figure 2.1: Studio 5 Front Panel

From left to right, the front panel ports,
LED’s and buttons are as follows:

MIDI Ports 14 and 15
These two pairs of MIDI ports are on the
front panel to facilitate quick, temporary
connection of synthesizers, controllers or
other MIDI devices. MIDI ports are discussed in detail in The Studio 5 Rear
Panel (pg. 7).
MIDI port pairs 14 and 15 are in addition
to the thirteen MIDI port pairs found on
the rear panel.

MIDI Activity LEDs
These Light Emitting Diodes (LEDs) indicate MIDI activity at any of the fifteen
pairs of MIDI ports. The top row of red
LEDs indicates when MIDI data arrives at
one or more of the Studio 5’s fifteen MIDI
IN ports. The bottom row of green LEDs
indicates when MIDI data leaves one or
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Patch Number Display
This three-digit display shows the
Studio 5’s current OMS Studio Patch. It
also displays error messages should the
Studio 5 experience difficulty (see
Appendix B: Troubleshooting). A zero (0)
is displayed when there are no patches
stored in the Studio 5—this happens
either the first time you turn on the interface or after you reset it. See the
Studio Patches manual for more information about Studio Patches.

Increment/Decrement Buttons
The increment/decrement buttons have
three uses:
•

Primarily, they allow you to step
through the Studio 5’s Studio Patches
patches as defined by the current
Patch document. Patch documents
are discussed in the Studio Patches
manual. The Studio 5 is “smart”
because it knows exactly how many
patches you have defined. Assume,
for example, that you have defined
three patches numbered 1, 15 and 78.
When you push the top (increment)

5

•

•
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button, you step from patch 1 to patch
15. Press it again, and you’ll step to
patch 78. The Studio 5 stores only as
many patches as you have defined,
thus expediting front-panel patch
access. Hold down either button to
increment or decrement
continuously.
You can use the increment/decrement buttons to reset the Studio 5
and clear all OMS patches from its
memory. To do this, hold down both
buttons while turning on the Studio 5.
You won’t need to reset the Studio 5
unless it loses communication with
the Macintosh and traditional methods (such as choosing Studio 5>Reestablish Communication or
switching the Studio 5 off and then on
again) do not correct the problem.
When the Studio 5 is on, pushing the
increment and decrement buttons
simultaneously acts as a “panic button,” silencing any MIDI devices that
are connected to the Studio 5. The
panic feature causes the Studio 5 to
perform the following operations (in
order):
First, it sends a Sustain Pedal Off
MIDI control message to all 16 MIDI
channels on all 15 MIDI OUT ports.
Then, it sends a MIDI All Notes Off
command to each channel on each
port.
Finally, it sends MIDI Note Off commands for all 128 notes to each
channel on each port. This is because
some MIDI devices don’t recognize
the MIDI All Notes Off command.

Thru Switches, A & B
These switches provide convenient
access to printers, modems or other
peripherals.
When a MIDI/Thru switch is in the MIDI
position, the Studio 5 is in MIDI mode—
transmitting MIDI data between your
Macintosh and various studio devices.
When a MIDI/Thru switch is in the
THRU position, data from the Macintosh
(as received on either the “A” or “B” input
port) is passed through the Studio 5 to the
“A” or “B” THRU ports on the rear panel.
Set a Thru switch to the THRU position
when your Macintosh needs to communicate with an external peripheral (such as a
printer or modem).
NOTE: The routing of MIDI inputs to
MIDI outputs (as defined by the current
Studio Patch) is not affected by these
switches.

SMPTE/Power Indicator Light
This LED blinks when there is SMPTE
activity, or when a signal is present at the
AUDIO IN jack. When no time code is
sent or received (or Audio In mode is not
employed) the LED is lit as a power
indicator.
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Power Switch
When pushed in at the bottom (“0”), the
power is OFF. When pushed in at the top
(“1”), the power is ON. The SMPTE/
Power LED should light when the switch
is in the ON position, if the power cord is
connected to the Studio 5 and plugged in.
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Figure 2.2: Studio 5 Rear Panel

Clockwise from the upper left, the
Studio 5’s rear panel connectors are as
follows:

Footswitch Connectors
Use these 1/4” phone jacks to connect
two momentary footswitches and a continuous foot pedal. Footswitches and foot
pedals are available from Opcode Systems
or your local music dealer.
FC1
Use this input to connect an optional continuous control foot pedal (Opcode’s foot
controller uses a 100k logarithmic taper).
The Studio 5 reads the position of the
pedal and interprets a MIDI value
between 0 and 127. Foot controllers are
ideal MIDI controllers for such effects as
panning, portamento or volume control.
You may turn the foot controller feature
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on or off within the OMS Setup application. See Foot Controller In (pg. 47) for
details. FC1 normally transmits on Channel 15 and is assigned to MIDI controller
number 15.
FS1 and FS2
Use these two inputs to connect optional
momentary (on/off) footswitches. The
Studio 5 sends a value of 127 when the
foot pedal is depressed and a value of zero
(0) when the foot pedal is released. FS1 is
MIDI controller number 78; FS2 is
number 79.
You can use either a normally open or
normally closed footswitch—the Studio 5
recognizes the type upon powering up.
You must plug in the footswitches prior to
turning on the Studio 5—this will enable
the unit to recognize the footswitches’
polarity. Do not step on any footswitches
while turning on the Studio 5 so that the
correct polarity can be determined.
NOTE: The footswitches and foot controller
will normally transmit on Channel 15.
This channel can be changed when the footswitches and the foot controller are used in
Studio Patches or as Virtual Controllers.
See the Studio Patches Manual.
Footswitches make ideal MIDIKeys in
Opcode’s Vision sequencer—one switch
could be used as the MIDIShift. The foot
controller can also be used to control any
of the faders.
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Audio/SMPTE Connectors

MIDI IN Connectors

These three connectors are used for
SMPTE and audio sync. They are unbalanced stereo connectors capable of
accepting either 1/4” mono phone plugs
or stereo tip/ring/sleeve connectors.
Input impedance is 500 kW. SMPTE
output impedance is less than 5 W.

Connect these ports to the MIDI OUT
ports of your MIDI devices. Two additional MIDI inputs are on the front panel.

Audio IN
This is an audio input that Vision or
Studio Vision can use as a sync source.
You can use any steady audio beat like a
drum or bass as the timing source. This
lets you synchronize MIDI tracks to material on tape that was recorded without
using SMPTE time code. For a tutorial,
see Appendix A: Using Audio In with
Vision.
SMPTE IN
This jack receives SMPTE time code from
a tape deck or other SMPTE source. The
Studio 5 converts the SMPTE input into
the MIDI format specified by the Stripe
SMPTE Window (see Chapter 6: SMPTE
Functions).
SMPTE OUT
This jack outputs SMPTE time code generated (or regenerated) by the Studio 5. It
is normally connected to the line input of
a tape deck. You may set the SMPTE
output level in the Stripe SMPTE Window
(See Chapter 6: SMPTE Functions).
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MIDI OUT Connectors
Connect these ports to the MIDI IN ports
of your MIDI devices. Two additional
MIDI outputs are on the front panel.

Computer Ports and THRU Ports
The Studio 5 does not implement the traditional Macintosh MIDI interface
concept of a “printer port” and a “modem
port.” When using older interfaces there
was a limit of 32 addressable MIDI channels, 16 on the printer port and 16 on the
modem port. The Studio 5, however, can
address up to 240 separate MIDI channels
using either or both serial inputs. These
input ports are labeled “A” and “B.” The
inputs (with the little Macintosh icons)
connect to the Macintosh using standard
8-pin mini-DIN serial cables (supplied by
Opcode with the Studio 5).
It doesn’t matter whether the “A” or “B”
ports are connected to the Mac’s modem
or printer ports—only that you remember
which way you did it.
IMPORTANT: If you are using only one
Studio 5 port, it must be the A port, regardless of whether it is connected to the
Macintosh’s modem or printer port.

Opcode Systems, Inc.
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Attach external peripherals (such as a
printer or modem) to the “A THRU” and/
or “B THRU” ports on the Studio 5. You
can use these peripherals without disconnecting the Studio 5 from the Mac. Simply
use the corresponding front panel MIDI/
Thru switch to route data arriving at one
of the Studio 5’s computer ports to its corresponding THRU port. See Thru
Switches, A & B (pg. 6) and Computer
Connections—One Studio 5 (pg. 11).

You should use only high quality shielded
MIDI and audio cables when operating
your Studio 5 or any other professional
audio equipment.

Power Cord Connector and Fuse
The factory supplied 3-prong power cord
plugs into this socket. Note that units are
shipped from the factory configured for
either 110V or 220V and are supplied with
the appropriate cables. Check that you
have the correct model for the voltage in
the country where you will be using your
unit. Should your Studio 5 ever require a
change in voltage, it can be modified by a
qualified technician.
The Studio 5 uses a 1 amp/250V fast blow
fuse. It should be replaced only with the
same type and rating.

ABOUT THE INTERFACE
CABLES
The Studio 5 comes with standard 8-pin
mini-DIN cables. If you are using cables
other than the ones supplied with the
Studio 5, please be certain they are equivalent to 8-pin mini-DIN cables such as
Apple’s System Peripheral-8 cable.

Studio 5 Manual
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Rack ears are provided for rack mounting
the Studio 5. If you wish to rack mount
your Studio 5, connect these ears to both
sides of the unit with the provided screws
(see Figure 3.1).

Attach the four rubber feet (provided) to
the bottom of the unit to prevent it from
sliding.
NOTE: To avoid interference with your
monitor, the Studio 5 should be located at
least two feet away from the computer’s
video display.

COMPUTER CONNECTIONS—
ONE STUDIO 5
Figure 3.1: Installing Rack Mount Ears

Use the provided rack mounting screws
to mount the Studio 5 in a standard 19”
equipment rack (as shown in Figure 3.2).
When placing the Studio 5 in a rack, you
should leave at least 1” clearance above
and below it.

Figure 3.2: Rack Installation

If you do not wish to rack mount the
Studio 5, it can rest on a steady surface.
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You can connect the Studio 5 to the Macintosh’s modem or printer port, or to
both. Connect the supplied serial cables
between the Studio 5 and the Mac as discussed in the following sections.

Single Port Connection
Single port connections are useful if you
frequently use one of the Mac’s serial
ports for non-MIDI purposes (such as
printing) while running MIDI applications. You can use the spare Macintosh
serial port without using the Studio 5’s
front panel MIDI/Thru switch.
Figure 3.3 illustrates a common single
port connection. You can connect either
the Mac’s printer port or modem port to
the “A” port of the Studio 5.
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IMPORTANT: If you are using only one
Macintosh serial port for MIDI (either
modem or printer), that port must be connected to the Studio 5’s “A” port.

PRINTER

MACINTOSH

FC1

FS1

FS2 AUDIO

IN

MIDI IN

SMPTE

IN

OUT

13

B

B
THRU

A

A
THRU

12

11

10

9

8

7

6

5

4

3

2

1

MIDI OUT

When using a dual-port connection, it
doesn’t matter which of the Mac’s serial
ports (modem or printer) are connected
to the Studio 5’s “A” (or “B”) port.
Figure 3.4 illustrates a dual port connection. Connect both Macintosh serial ports
to the Studio 5, and attach any external
peripherals to the Studio 5’s THRU jacks.
You can switch between the Studio 5 and
the external peripherals by using the corresponding MIDI/Thru switch on the
front panel.

MODEM

Figure 3.3: Single Port Connection, Modem

The example shown in Figure 3.3 uses
only the modem port for communicating
with the Studio 5. As a result, you can connect an external peripheral (such as a
printer, in this example) directly to the
printer port. You can connect an additional peripheral (such as a modem) to
the “A THRU” jack on the Studio 5 and
switch it in or out with the front panel’s
corresponding MIDI/Thru switch.

Dual Port Connection
Use a dual port connection if you need
increased MIDI “throughput” (for example, your MIDI data is densely packed
with notes, continuous controllers,
system exclusive messages and MIDI
Time Code). It’s a good idea to always use
a dual port connection when synchronizing MIDI playback with SMPTE time
code.
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MODEM

Figure 3.4: Dual Port Connection

NOTE: When transmitting data in a dual
port configuration, as shown in Figure 3.4,
the Studio 5 distributes MIDI equitably
between ports “A” and “B.”
However, when the Studio 5 receives data,
information from MIDI instruments enters
port “A” while MIDI generated by the
Studio 5 (time code, footswitch and foot
controller info, and Audio In events) enters
port “B.” Separating the incoming time
code from incoming MIDI messages provides insures accurate synchronization.
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COMPUTER CONNECTIONS—
NETWORKING
A network is defined as the connection of
one or more Studio 5’s to a single Macintosh serial port. The Macintosh has two
serial ports, so it can support two networks. You may connect up to six
Studio 5’s to a single Macintosh (two networks of three Studio 5’s) for a total of 90
MIDI ports and 1,440 MIDI channels. For
details, see Chapter 7: Networking.

Studio 5 to the audio output of the multitrack’s SMPTE track. Connect the
Studio 5 directly to the tape deck, bypassing the mixing console, equalizer, or any
other signal processing equipment.
Audio Trigger

Audio Out
Audio In

FC1

FS1

FS2 AUDIO

IN

MIDI IN

SMPTE

IN

OUT

13

B

B
THRU

A

12

11

10

9

A
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8

7

6

5

4

3

2

1

MIDI OUT

AUDIO CONNECTIONS

Figure 3.5: Audio Connections

The Studio 5 has three audio jacks on its
rear panel. The SMPTE IN jack is used to
receive a SMPTE time code signal. The
SMPTE OUT jack sends SMPTE time
code as specified in the Stripe SMPTE
Window, discussed in Chapter 6: SMPTE
Functions.

To use the Studio 5 as a tempo controller,
connect its AUDIO IN jack to the output
of any device or instrument providing a
rhythmic pulse (such as a bass drum,
bass guitar, click track, etc.). Vision and
Studio Vision can sync to an audio trigger
received at this input. For a tutorial, see

When receiving SMPTE at its SMPTE IN
jack, the Studio 5 duplicates this time
code and echoes it out the SMPTE OUT
jack. The AUDIO IN jack is used to
receive an audio trigger signal.

Appendix A: Using Audio In with
Vision on page 49.

To use the Studio 5 as a synchronization
device, connect a pair of shielded audio
cables between the Studio 5 and a multitrack tape deck. Connect the SMPTE
OUT jack to the audio input of a tape deck
for SMPTE striping (usually the last
track). Connect the SMPTE IN jack of the
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MIDI CONNECTIONS
Connect a MIDI device’s MIDI input to a
Studio 5 MIDI OUT port. Connect the
like-numbered Studio 5 MIDI IN port to
the device’s MIDI output. Figure 3.6
shows some typical MIDI connections.

The Studio Patches Manual discusses
using footswitches with OMS Patches. If
using Vision or Studio Vision, consult
your manual on using footswitches with
MIDIKeys.

FC1

IN OUT

FS1

FS2 AUDIO

IN OUT

IN

MIDI IN

SMPTE

IN

OUT
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Figure 3.7: Footswitch Connections
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MIDI EFFECTS
B
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POWERING UP THE STUDIO 5
IN OUT

SYNTH MODULE

IN OUT

DRUM MACHINE

IN OUT

SYNTHESIZER

Figure 3.6: MIDI Connections

NOTE: If you wish to retrieve patches from
a device using Opcode’s Galaxy program,
you must connect that device’s MIDI IN
and OUT ports to identically-numbered
ports on the Studio 5 (as shown in
Figure 3.6).

FOOTSWITCH CONNECTIONS
You can connect two optional footswitches (FS1 and FS2) and an optional
foot pedal (FC1) to the Studio 5. These
footswitches perform numerous programmable functions depending on the Mac
software being used. For more information, see Footswitch Connectors (pg. 7).
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When powering up the Studio 5, it goes
through a process called network synchronization. During this time, the
Studio 5 examines both of its serial ports
to see what is connected. As this is done,
you’ll see it display the number “1” in the
middle of its display for one second, and
then display the current Studio Patch
number. The “1” indicates that the
Studio 5 is connected to a Macintosh. The
current patch will be “0” the first time the
unit is turned on. Later, as patches are
defined and stored, the Studio 5 remembers the last patch selected prior to
shutting down.
NOTE: Networked Studio 5’s, when powered up, display their network number for
one second before displaying the current
patch number. See Chapter 7: Networking
for networking details.
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INSTALL AND CONFIGURE OMS
To use the Studio 5 you must install and
configure the Open Music System
(OMS). OMS keeps track of how your
MIDI studio is connected and configured
and stores this information in Studio
Setup documents. Studio Setups are created and edited in the OMS Setup
application.
NOTE: If you are unfamiliar with OMS,
you should stop and read the OMS manual
before continuing.
To install and configure OMS:
햲 Insert the provided OMS disk 1 and
double-click Install OMS.
At the initial prompt, specify you are
using a Studio 5.

햳 When reaching the main install
screen, choose the ÒEasy InstallÓ
option and then click the Install
button.

햴 Insert each disk as prompted.
햵 When completed, exit the installer
and restart your Macintosh.
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햶 After restarting, launch the
OMS Setup application and
configure a ÒNew Studio Setup.Ó

Consult your OMS manual for details on
installation and Studio Setup
configuration.

NOTE: If you encounter installation problems, disable any extensions or control
panels that may be causing a conflict. The
easiest way to do this is to restart your Mac
while holding down the shift-key.
If turned on and connected properly, the
Studio 5 is automatically detected by
OMS when configuring a new Studio
Setup. Once OMS knows that you’re
using a Studio 5, a Studio 5 menu
appears in the OMS Setup application.
Use this menu to stripe and monitor
SMPTE, access the Compatibility Setup,
set the Communication Speed, and check
the ROM Version. For an explanation of
each menu item, see Chapter 8: Studio 5
Menu.
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OMS Studio Patches
OMS Studio Patches provide advanced
MIDI processing capabilities for the
Studio 5. Studio Patches are created in
the Studio Patches Editor and stored in
Patch documents.

Some OMS applications require you to
enable MIDI input devices—that is, you
need to tell the application which MIDI
device(s) you’ll use to input MIDI data.
Figure 4.1 illustrates Vision’s Enable
Inputs dialog where OMS devices are
enabled as input devices.

An important thing to realize about Studio
Patches is that they reside in the
Studio 5’s internal memory. This means
that when a patch is chosen (from the
front panel), its settings are always
active—whether a MIDI software program is running, or even if the Studio 5 is
not connected to a computer.
Consult the Studio Patches manual
included with your Studio 5 package for
more information.
Figure 4.1: Enabling Inputs in Vision

USING THE STUDIO 5 WITH
MIDI APPLICATIONS
Unless you use the Studio 5 strictly for
live performance, you’ll probably use it
with sequencers, editor/librarians and
other MIDI applications.

OMS Applications
Once you have configured an OMS
Studio Setup, using OMS-compatible
applications is quite seamless. Any
devices contained in your Studio Setup
are automatically available in OMS applications, and you can even select them by
name. If at some point you make changes
in your current Studio Setup, OMS applications are updated.
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In this example, the GeoSkin Drums, Gizmotronics and MIDI Tuba are enabled as
input devices (checked). As a result,
Vision “sees” MIDI data only from these
devices. Data from other devices connected to the Studio 5 is not sent to
Vision.
OMS applications can also specify the
Studio 5 as a source for MIDI input; in
doing so, data generated by the Studio 5
(time code, foot controller and footswitches, and Audio In events) is sent to
the application. If you wish to receive
SMPTE time code, make sure to choose
the Studio 5 as the sync source.
If you are using Studio Patches and have
created a Studio Patches document, any
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of its “virtual instruments” and “virtual
controllers” are also accessible from OMS
applications.
Consult your MIDI application manuals
for more details on how it interacts with
OMS.

Using the Studio 5 with Non-OMS
Applications
If using the Studio 5 with non-OMS applications, see Chapter 5: Using the Studio 5
with Non-OMS MIDI Software.

SETTING A COMMUNICATION
SPEED
You can specify the speeds at which your
Macintosh and Studio 5 communicate
with each other. Generally, most applications will work with the default values.
However, if you get overrun messages, or
if you wish to increase MIDI throughput,
you can adjust the communication
speeds.
From within the OMS Setup application,
choose Studio 5>Fast Mode Communication Speed to open the
Communication Speed dialog box.
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Figure 4.2: Communication Speed Dialog Box

Use this dialog to set a communication
speed between the Macintosh and the
Studio 5. Greater data throughput is
obtained by transferring data at speeds
faster than the MIDI standard. This can
result in an increase in the number of
simultaneous MIDI channels as well as
improved timing—particularly in
sequences with a dense MIDI data stream
(e.g. numerous chords, 16th notes, timing
information, and continuous controllers).
A Macintosh->Studio 5 communication
speed of 8 x MIDI should work in most
instances, as should a Studio 5->Macintosh speed of 1.5 x MIDI. It may be
possible to increase the Studio 5->Macintosh speed on some computers
(depending on which software is running), thereby allowing more
simultaneous MIDI data to be transmitted
to the Macintosh (e.g. playing multiple
controllers). If you encounter warning
messages indicating that overrun errors
have occurred, you’ll need to decrease the
Studio 5->Mac communication speed.
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To test the Studio 5->Macintosh communication speed, choose a serial port, check
the Continuous check box, then click the
Test button. The Studio 5 will begin to
send about 4K of MIDI at the current
speed settings. Click the mouse to stop
continuous testing—any data loss will be
reported.
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Using the Studio 5 with
Non-OMS MIDI Software

This chapter discusses using the Studio 5
with non-OMS MIDI applications. If you
will always use the Studio 5 with OMS
applications (such as Vision, Studio
Vision, Galaxy, Overture, and MAX), you
will not need to use the Compatibility
Setup Window and may skip ahead to the
next chapter. If you plan to use the
Studio 5 mainly with OMS applications,
you may still wish to skip ahead to the
next chapter, returning to this section
when you’re ready to use a non-OMS
application. If you will be using mostly
non-OMS applications, read this chapter
now.

When OMS is active, the Studio 5 is automatically in “OMS Mode.” When OMS
becomes inactive, the Studio 5 returns to
standard interface mode. OMS is active if
an OMS application is currently being
used, or if OMS is set to “Run MIDI in
background.” When OMS is active, the
Studio 5 operates transparently; applications send and receive to individual MIDI
devices.

The Studio 5 requires OMS for its configuration, but it can be used with non-OMS
MIDI software via its Compatibility
Mode. This mode configures the Studio 5
to emulate either a standard MIDI interface or MIDI Time Piece (MTP).

NOTE: An important thing to remember is
that Studio Patches reside in the Studio 5’s
internal memory. This means that when a
patch is chosen (from the front panel), its
settings are always active—no matter what
type of MIDI software is running, or even if
the Studio 5 is not connected to a computer.

NOTE: If OMS is set to “Run MIDI in the
background,” OMS remains active even
when a launched OMS application is not
the current application.

By default, the Studio 5 acts like a standard interface, as defined by the current
compatibility setup, with non-OMS applications. When Performer or some other
MTP-aware program becomes active, the
Studio 5 switches from standard interface
emulation into MTP emulation. Similarly,
when an MTP-aware program becomes
inactive, the Studio 5 switches back into
standard interface emulation.

Studio 5 Manual
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THE COMPATIBILITY SETUP
WINDOW
To configure the Studio 5’s Compatibility
Mode, open the OMS Setup application
and choose Studio 5>Compatibility
Setup. The Compatibility Setup Window
opens, similar to Figure 5.1.

Figure 5.2: Compatibility Setup Window (Modem
Port connected to Port A)

IMPORTANT: If you are using only one
Macintosh serial port for MIDI (either
modem or printer), be certain to connect
that port to the Studio 5’s “A” port.

Figure 5.1: Compatibility Setup Window, 2 ports

The large area in the center of the window
contains pop-up menus for choosing
devices contained in the current Studio
Setup. The left half of the window represents the Mac’s modem port, the right
represents the printer port.
If the Studio 5 is connected to just one
port, the Compatibility Setup Window displays only that port (as shown in
Figure 5.2).
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Speed pop-up menu
This must match the interface speed specified within your non-OMS MIDI
application. Choose 1 MHz if your MIDI
applications do not support Fast mode. A
1 MHz communication speed is used by
most standard MIDI interfaces (such as
Opcode’s MIDI Translator II). If your
application supports a Fast mode and you
wish to use it, choose Fast.
To set the Fast mode speed, choose
Studio 5>Fast Mode Communication
Speed and select transfer speeds from
the pop-up menus. SeeSetting a Communication Speed (pg. 17) for more details.
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IMPORTANT: If you plan to transmit
system exclusive messages from the Macintosh, you must use a Compatibility Setup
Speed of 1 MHz to insure successful data
transfer. OMS applications are unaffected
by this setting and can transfer system
exclusive messages in Fast mode.

Open...
This button opens a standard Macintosh
dialog box from which you may open any
stored Compatibility Setup document.

Save As...
View pop-up menu
The pop-up View menu offers a choice of
four different views—Standard Interface In, Standard Interface Out, MIDI
Time Piece In, and MIDI Time Piece
Out. Select a view to change the display
in the lower portion of the Compatibility
Setup Window. Use the View menu to see
and change various aspects of the
interface.

Emulate MIDI Time Piece check
box
If Emulate MIDI Time Piece is
checked, the Studio 5 emulates Mark of
the Unicorn’s MIDI Time Piece and all
views, except Standard Interface In are
enabled. If Emulate MIDI Time Piece
is not checked, the Studio 5 emulates a
standard MIDI interface and only Standard Interface In and Standard Interface
Out views can be selected.
NOTE: Mark of the Unicorn’s Performer
sends messages that put the Studio 5 into
MIDI Time Piece emulation mode—even if
you tell Performer you only have a standard
MIDI interface. Performer users should
check the Emulate MIDI Time Piece
option.
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This button opens a standard Macintosh
“Save As” dialog box for saving Compatibility Setups. Since the current
Compatibility settings are kept within the
Studio 5 driver, you should save all current settings before updating the Studio 5
driver.

Auto
This button uses the current Studio Setup
to make sensible default assignments for
all of the pop-up menus in the current
view. The Auto button yields different
results depending on which view is active.
NOTE: The following information is better
understood after you’ve learned to use each
of the compatibility views. It’s presented
here for easy reference.
For Standard Interface In, the Auto
button enables the controllers and sync
sources. If you have both the modem and
printer ports connected, controllers are
routed to the Studio 5’s “A” port (usually
connected to the Mac’s modem port), and
the sync sources (including the Studio 5’s
time code) are routed to the “B” port. A
controller that sends sync is routed to the
Studio 5’s “B” port.
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For Standard Interface Out, the Auto
button routes each MIDI channel only to
devices that are set to receive on that
channel. “MIDI beat clock” and time code
are routed only to devices that receive
sync. Other system events are routed to
all devices. If you have both the modem
and printer ports connected, devices on
MIDI ports 1-8 are assigned to port “A,”
ports 9-15 to port “B.”

THE FOUR COMPATIBILITY
VIEWS
This section discusses how to set up and
edit each of the four possible compatibility views.

Standard Interface In View

For MIDI Time Piece In, the Auto
button enables the controllers and sync
sources. Controllers are assigned to the
MIDI Time Piece cable numbers that
match the Studio 5 port numbers to which
they’re connected. If you are using both
the modem and printer ports, Studio 5
time code, footswitch, and audio data
enters the “B” port. Everything else
comes in the “A” port.
For MIDI Time Piece Out, the Auto
button routes cable 1 to the device on
Studio 5 port 1, cable 2 to the device on
Studio 5 port 2, and so on. Sync is routed
to all devices that receive sync. “All” is not
routed to anything by default, but can be
set manually to any device or Virtual
Instrument.

Clear All
This button clears all port (or cable) selections for the current view.

Figure 5.3: Standard Interface In View

Use this view to enable Studio 5 inputs
when emulating a standard MIDI interface. There is one pop-up menu per port.
From this menu, you can choose to
enable any number of devices and Virtual
Controllers. All enabled devices can send
data to the Macintosh. Enabled devices
have check marks next to their names in
the pop-up menu. To enable a device,
choose it from the pop-up menu (a check
will appear). To disable a device, choose it
again (the check will disappear).
NOTE: This view is available only if Emulate MIDI Time Piece is not checked,
however all devices enabled in the MIDI
Time Piece In view are enabled when the
Studio 5 emulates a standard MIDI
interface.

22

Opcode Systems, Inc.

CHAPTER 5: Using the Studio 5 with Non-OMS MIDI Software

As an example, assume that your current
Studio Setup looks like Figure 5.4:

Standard Interface Out View

Figure 5.6: Standard Interface Out View

Figure 5.4: Sample Studio Setup Document

You can enable any and all devices for
Macintosh input by checking them in the
pop-up menu. You could also use the
Auto button to assign devices automatically according to the rules specified
earlier in this chapter.

There are 22 pop-up menus per port—one
for each of the 16 MIDI channels, plus six
others for various non-channel-specific
MIDI system events. Choose from each
pop-up menu any number of devices or
Virtual Instruments that need to receive
data of the specified type or MIDI channel. You may also route a channel to the
Studio Patches Pgm Chg device. Program
changes received on this channel select
Studio Patches contained in the Studio 5.
If, for example, your current Studio Setup
is as displayed in Figure 5.4, then you
could enable a device (or devices) for

Figure 5.5: Enabling Standard Interface Inputs
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each of the 16 MIDI channels as well as
for various MIDI system events.

MIDI Time Piece In View

Figure 5.8: MIDI Time Piece In View
Figure 5.7: Enabling Standard Interface Outputs

In Figure 5.7, the Digiwhiz 2000 responds
to data on channels 1 and 2, the ProMaker/1 receives on MIDI Channels 3
through 5, the Vectorific receives on
Channels 6 through 9, and the Banger
Man II drum module responds on MIDI
Channel 10. All devices will receive active
sensing, system exclusive, and miscellaneous MIDI system messages. Beat
Clock and time code are sent only to the
Banger Man II since it’s the only device
defined in the current Studio Setup that
receives this type of data.
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There are 17 pop-up menus per port—one
for each of the 17 possible MIDI Time
Piece cables. Choose, from each pop-up
menu, those devices or Virtual Controllers that will send data to the Macintosh.
The chosen devices or Virtual Controllers
will appear to the Macintosh application
as having been sent from the MIDI Time
Piece cable number next to the menu.
NOTE: All enabled controllers in the MIDI
Time Piece In view are also enabled when
the Studio 5 is in standard interface mode.
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MIDI Time Piece Out View

Using Output Cables
A single Studio 5 emulates two networked
MIDI Time Pieces. If you have both serial
ports connected to the Studio 5, you will
still see only one set of output cables in
the Compatibility Setup Window—the
Studio 5 does not distinguish between a
cable on the modem port and a cable on
the printer port.

Figure 5.9: MIDI Time Piece Out View

There are 19 pop-up menus—including
one for each of the 16 possible MIDI Time
Piece cables. Choose the device or instrument from a cable’s pop-up menu. In
addition, there is a pop-up menu that represents the MIDI Time Piece’s Network
port (cable 17). “Sync” can be sent to any
device or devices enabled for sync in the
current Studio Setup document. “All”
determines which device or Virtual
Instrument is controlled by the “All” setting in Performer. You may also route a
cable to the Studio Patches Pgm Chg
device. Program changes received on this
cable will select Studio Patches contained
in the Studio 5.
NOTE: Cable numbers do not necessarily
have to correspond to Studio 5 port numbers (although this is the default mode if the
Auto button is used). Each cable can be
assigned to any device or Virtual Instrument of your choice.
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Cable numbers have a specific and permanent meaning in the MIDI Time Piece:
MIDI Time Piece #1 sends data to cables
1-8, MIDI Time Piece #2 sends data to
cables 9-16, cable 17 is an optional standard interface connected to any MTP
serial port (typically the network port of a
single MTP, or the computer port of a
second MTP), and “All” sends data to all
17 MIDI Time Piece cables.
With the Studio 5, you can assign any
device or Virtual Instrument to any cable.
This is much more flexible than the rigid
MIDI Time Piece cable assignment
described in the previous paragraph.
Notice that there are three more cables
(16, 17, and “All”) than Studio 5 MIDI
ports. You could, as an example, assign
the device attached to MIDI port 1 to
cable 1, the device attached to MIDI port
2 to cable 2, and so on up to cable 15
(although any device or Virtual Instrument can be routed to any cable). This
still leaves three cables free for complex
routing schemes involving Virtual
Instruments.
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Sync pop-up menu
This menu allows you to send sync to any
single device or Virtual Instrument. If you
need to send sync to more than one
device, create a Virtual Instrument consisting of a simple splitter routed to all
devices that need to receive sync. Then
choose that Virtual Instrument in the
Sync pop-up menu. See the Studio
Patches manual for more information
about Virtual Instruments.

Assume that you have the simple studio
shown in Figure 5.10. Your Gizmatronics
master keyboard controller is plugged
into MIDI port pair 2, a Proteus/1 sound
module is plugged into MIDI port pair 7,
and the Macintosh Modem port is connected to the Studio 5 “A” port.
MACINTOSH
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2

1

MIDI OUT

All pop-up menu
Implementation of the Studio 5’s “All”
function is slightly different (but much
more flexible) than the “All” interaction
between the MIDI Time Piece and Performer. In Performer, sending to “All
Cables” causes data to be sent out all
cables on that serial port.
When a Studio 5 emulates a MIDI Time
Piece, you define what “All” means. The
“All” cable can send data to a device from
the current Studio Setup or even to a Virtual Instrument.

IN OUT

IN OUT

PROTEUS/1

GIZMATRONICS

Figure 5.10: Sample MIDI Connections

햲 Open the OMS Setup application and
choose Studio 5>Compatibility
Setup.

햳 Verify that Emulate MIDI Time
Piece is NOT checked since you
want the Studio 5 to emulate a
standard MIDI interface.

햴 Choose Standard Interface In from
the View pop-up menu.

COMPATIBILITY SETUP
EXAMPLE: EMULATING A
STANDARD INTERFACE
In the following example you’ll use the
Studio 5 to emulate a Standard MIDI
Interface. You’ll work with Opcode’s
EZ Vision sequencer.
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햵 Choose MIDI source devices from the
ÒAÓ port side of the Compatibility
Setup Window.
In your simple studio you have only two
devices; a Gizmatronics keyboard and a
Proteus/1, as shown below.

Figure 5.12: Standard Interface Out Setup

햸 Select patch number 1 on the
Studio 5. This should be defined as
your Òdo nothingÓ patchÑthe patch
used for sequencing applications.
Figure 5.11: Standard Interface In Setup

햶 Choose Standard Interface Out
from the View pop-up menu.

햷 Select those devices that will be MIDI

햹 Launch EZ Vision.
햺 Choose Setups>MIDI Setup and
make sure the modem port is
enabled, MIDI Manager is off, and the
interface speed is set for 1 MHz.

destinations from the ÒAÓ port side of
the Compatibility Window (or use the
Auto button).
Since your simple studio has only one
sound module, youÕll send all 16 MIDI
channels on the modem port to the Proteus/1. YouÕll also enable other types of
MIDI messages to be sent to the Proteus/1.

Figure 5.13: EZ Vision MIDI Setup Window

EZ Vision can now be used as though
attached to any standard MIDI Interface
(such as an Opcode Studio 3 or MIDI
Translator).
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You control SMPTE functions with two
windows that are accessed from the
Studio 5 menu in OMS Setup:
•
•

SMPTE Reader Window
Stripe SMPTE Window

The following sections discuss these two
windows and provide a syncing tutorial.

SMPTE READER WINDOW
Choose Studio 5>SMPTE Reader to
open the SMPTE Reader Window.

From top to bottom, the SMPTE Reader
Window contains a time code display,
User Bits display, Rate display, Format
pop-up menu and Full Message display.
These are discussed in the following
sections.

time Code Display
This SMPTE Reader displays the SMPTE
time code signal received at the SMPTE
IN jack of the Studio 5, unless the
Studio 5 is striping; then it displays the
SMPTE time code being striped. It uses
the MIDI format (MTC/DTL/DTLe)
specified in the Format pop-up menu.
NOTE: The SMPTE Reader cannot distinguish between 29.97 non-drop and 30 nondrop. When the Studio 5 is reading a frame
rate of 29.97 non-drop, the SMPTE Reader
displays the rate as 30 non-drop.

User Bits Display

Figure 6.1: SMPTE Reader Window

Studio 5 Manual

If you choose MTC from the Format
pop-up menu, then any user bits that are
encoded with the SMPTE time code are
displayed in the user bits display. User
bits cannot be read if you use DTL or
DTLe as the MIDI synchronization for-
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mat. For more information about user
bits, see User Bits (pg. 34).

Rate Display
This area displays the SMPTE frame rate
of the incoming SMPTE signal.

Format Menu

•

•

•

MTC: The Macintosh uses MIDI
Time Code to read the value of the
SMPTE signal.
DTL: The Macintosh uses Direct
Time Lock to read the value of the
SMPTE signal.
DTLe: The Macintosh uses
Enhanced Direct Time Lock to read
the value of the SMPTE signal.

DTL NOTE: There is one important point
you need to consider when using either
Direct Time Lock or Enhanced Direct Time
Lock: DTL and MIDI Beat Clock use identical messages. Consequently, any MIDI
Beat Clock messages received by the
Studio 5 merge with DTL messages generated by the Studio 5, making both messages
unreadable. Therefore, when you sync your
sequencer to DTL, you must not allow any
devices to send MIDI Beat Clock to the
Macintosh. Either stop the device from
sending MIDI Beat Clock (use a Studio
Patch to mute the MIDI Beat Clock messages) or use MIDI Time Code instead of
DTL.

Figure 6.2: Setting MIDI Format

From the Format pop-up menu, choose
the MIDI sync format your software will
use. This pop-up menu duplicates the
MIDI Format pop-up menu found in the
SMPTE Reader Window (see SMPTE
Reader Window (pg. 29)). The Studio 5
converts SMPTE time code into the MIDI
format specified in this pop-up menu. The
choices are:
•
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No Sync: The Studio 5 ignores the
SMPTE input signal. Also, it doesn’t
show time code when striping.

Full Message Display
If you choose MTC as the MIDI format,
then every time the Studio 5 achieves
sync, it generates a “Full Message.”
During a normal syncing situation, you
will get only one full message (when the
Studio 5 initially locks to tape). If the tape
is of poor quality or the SMPTE signal
isn’t strong enough, additional full messages are sent. Each full message
increments the counter and provides a
good way to check the quality of your tape
or incoming SMPTE signal. The SMPTE
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Reader Window doesn’t display Full Messages when using DTL or DTLe as the
MIDI sync format.

STRIPE SMPTE WINDOW
Choose Studio 5>Stripe SMPTE to
open the Stripe SMPTE Window.

Using the SMPTE Reader Window
with Multiple Studio 5’s
The SMPTE Reader displays the time
code received at the SMPTE IN jack of
the selected Studio 5. You must select a
Studio 5 from the bottom of the Studio 5
menu before opening the SMPTE Reader
Window. The SMPTE Reader Window
isn’t affected by new Studio 5 selections
after it’s open—the window continues to
work with the Studio 5 that was selected
at the time it was opened. The SMPTE
Reader displays the name of the Studio 5
that it is referencing.
Studio 5
Name

Figure 6.3: Studio 5 Identification in SMPTE
Reader

NOTE: If you have multiple Studio 5’s connected in a network (see Chapter 7:
Networking), you should use the Studio 5
that is connected directly to the Macintosh
for SMPTE functions.

Figure 6.4: Stripe SMPTE Window

The following sections discuss the
mechanics of this window. See SMPTE
Tutorial (pg. 35) for a step-by-step syncing tutorial.

Setting and Using Start and Stop
Times
The Start field contains the SMPTE start
time. Reading from left to right, the numbers represent hours, minutes, seconds
and frames.

Figure 6.5: SMPTE Start Field
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The Studio 5 can stop generating time
code automatically. This is especially
useful for unattended striping sessions.
You can enter a stop time value in the
Stop field. The check box to the left of the
Stop field turns on the automatic stop feature. If the box is checked and a value is
entered into the Stop field, the Studio 5
will automatically stop sending SMPTE
time code when that value is reached. If
the box is not checked, the Studio 5 will
ignore the Stop value, and continue striping until the Stop Striping button is
clicked.

01:33:00:00 into your Stop field, roll tape,
and press the Start Striping button.

Setting and Using SMPTE Frame
Rates

Figure 6.6: SMPTE Stop Field

The Studio 5 will begin to generate
SMPTE time code from its SMPTE OUT
jack as soon as the Start Striping button is
clicked. The SMPTE value will begin at
the time specified in the Start field. The
Studio 5 will cease to generate SMPTE
time code when the Stop Striping button
is clicked (or when the Stop field value is
reached and the Stop check box is
checked).
NOTE: The Stop check box must be checked
BEFORE clicking the Start Striping button. If you check the Stop check box AFTER
clicking Start Striping, then striping will
not stop automatically.
As an example, let’s say you wanted to
stripe a tape with exactly 33 minutes of
time code, and you wanted this stripe to
begin at 1 hour SMPTE time. You would
type 01:00:00:00 into your Start field,
check the Stop check box, enter
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Figure 6.7: Setting SMPTE Frame Rate

You can choose one of five SMPTE frame
rates from the Frame Rate pop-up menu.
When you click the Start Striping button,
the specified rate is generated within the
Studio 5 and sent to the SMPTE OUT
jack. The following is a brief description
of the various SMPTE frame rates.
•
•
•
•

24 Frame: Film frame rate.
25 Frame: EBU (European) television
frame rate.
29.97 Drop Frame: NTSC color television frame rate.
29.97 Non-Drop: Used to sync to
NTSC color television without dropping frames. SMPTE time does not
match real-time, but playback pitch is
unaffected.
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•

30 Non-Drop: Original NTSC black
and white television standard. Often
used in audio-only situations since
there are no dropped frames and the
SMPTE time is equal to real time.

•

DTLe: The Macintosh uses
Enhanced Direct Time Lock to read
the value of the SMPTE signal.

Guide to Setting SMPTE Levels

Setting and Using the MIDI
Format

Figure 6.9: Setting SMPTE Output Level

Figure 6.8: Setting MIDI Format

From the MIDI Format pop-up menu,
choose the MIDI sync format your software will use. This pop-up menu
duplicates the Format pop-up menu
found in the SMPTE Reader Window. The
Studio 5 converts SMPTE time code into
the MIDI format set in this pop-up menu.
The choices are:
•

•

•

No Sync: The Studio 5 ignores the
SMPTE input signal. Also, it doesn’t
show time code when striping.
MIDI Time Code: The Macintosh
uses MIDI Time Code to read the
value of the SMPTE signal.
Direct Time Lock: The Macintosh
uses Direct Time Lock to read the
value of the SMPTE signal.
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The Level pop-up menu lists eight settings for the SMPTE output level. Choose
one that provides the best input signal for
your particular tape recorder. The following guide covers the optimum input levels
for various types of machines. Choose a
level that gives a SMPTE input value closest to the following:
•

•

•

If your tape machine operates at
-10 dB, adjust the SMPTE output
level for a tape input of about -3 dB.
If your tape machine operates at
+4 dB, adjust the SMPTE output level
for a tape input of about -7dB.
If you are using a -10 dB machine
with LED metering, adjust the
SMPTE output level for a tape input
between -1 and -2 dB.
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•

•

If your recorder uses dbx noise
reduction and you can’t defeat it,
adjust the SMPTE output level for a
tape input between -1 and 0 dB.
If you have a mixer in the SMPTE
signal path (and you shouldn’t), make
sure that the equalization is either
switched out or flat. Any filtering of
the SMPTE signal will render it
invalid.

Jam Sync
The Studio 5 has a Jam Sync mode. In this
mode, it generates a fresh SMPTE signal
from the SMPTE OUT jack in sync with
the signal received at the SMPTE IN jack.
You should always use Jam Sync mode to
regenerate a SMPTE track when you
copy tapes; a copied SMPTE track may
degrade enough to make it unusable.
The Studio 5 is always in Jam Sync mode
unless you choose Off from the pop-up
Level menu in the Stripe SMPTE
Window.
If you want to copy a multitrack tape and
its SMPTE track, connect the Studio 5
between the two tape recorders and
enable Jam Sync mode by choosing a
value other than Off from the pop-up
Level menu. The Studio 5 will generate a
fresh copy of SMPTE from the original
tape’s signal regardless of any dropouts in
the original copy.

Start JamStripe™ Button
JamStripe™ takes Jam Sync one step further. If a tape has a very large drop-out in
the SMPTE signal, or if the SMPTE signal
stops at some point in the tape, JamStripe
will cause the Studio 5 to continue generating time code without having any
SMPTE present at the SMPTE IN jack.
To stop generating, click the Stop Striping button. If you have a tape in need of
this kind of service, click the Start JamStripe™ button when you make a copy of
the tape. The Studio 5 will Jam Sync until
it reaches the end of the SMPTE signal, at
which point it will switch seamlessly into
a generating mode.
NOTE: When Jam Syncing or JamStriping,
the SMPTE frame rate at the SMPTE OUT
jack is the same as that being received at
the SMPTE IN jack. The SMPTE Frame
Rate pop-up menu has nothing to do with
the SMPTE signal in either Jam Sync or
JamStripe modes. You can view the actual
SMPTE frame rate by using the SMPTE
Reader Window.

User Bits
This field allows you to enter user bits as
defined by the SMPTE standard. User
bits are often used to mark off and identify
various sections of a tape. User bits are
hexadecimal, so legal values are the numbers 0-9, and the letters A-F.

If you do not need to regenerate SMPTE
(such as when you’re using the Studio 5
to sync a sequencing application to tape),
you should disable Jam Sync.
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DTL NOTE: You can stripe time code that
includes user bits regardless of the MIDI
synchronization format you specify. However, if you’re reading time code using
either DTL or DTLe, user bits are not displayed in the SMPTE Reader Window.

Striping a Tape

Using the Stripe SMPTE Window
with Multiple Studio 5’s

To stripe a new tape with SMPTE time
code, familiarize yourself with the Stripe
SMPTE Window as well as the operation
of your tape recorder. A typical striping
operation might go something like this:

The Stripe SMPTE Window works with
the selected Studio 5. You must select a
Studio 5 from the Studio 5 menu before
opening the Stripe SMPTE Window. The
Stripe SMPTE Window isn’t affected by
new Studio 5 selections after it’s open—
the window continues to work with the
Studio 5 that was selected at the time it
was opened. The Stripe SMPTE Window
displays the name of the Studio 5 that it is
referencing.

Unless you already have tapes with
SMPTE on them, you will need to put
SMPTE time code onto a blank tape. This
process is usually called “striping” a tape
with SMPTE.

햲 Use a new roll of recording tape and
turn off any noise reduction on your
tape recorder. Do not use any
equalization or alter the SMPTE signal
in any way.

햳 Make sure that your Studio 5 is
connected as discussed in Audio
Connections (pg. 13).

햴 Launch OMS Setup and choose
Studio 5 Name

Studio 5>Stripe SMPTE to open
the Stripe SMPTE Window.

Figure 6.10: Studio 5 Identification in Stripe
SMPTE Window

SMPTE TUTORIAL
Follow through these tutorial sections to
learn how to stripe a tape with SMPTE
time code and to sync to SMPTE using
either Vision or Performer.

Figure 6.11: Stripe SMPTE Window

햵 Enter the SMPTE frame rate using the
Frame Rate pop-up menu. Enter a
Start time. If you wish the striping to
stop automatically, enter a Stop time
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and check the Stop check box. If
desired, enter the User Bits. Set a
SMPTE output level.

햶 Choose a MIDI Format.
햷 Put your tape recorder into Record
mode, but paused.

햸 Click the Start Striping button in the
Stripe SMPTE Window.
The Studio 5 SMPTE/Power LED will
begin to flash. You should see the
SMPTE signal level on your recorderÕs
input meters. Verify that the proper
amount of SMPTE signal is going onto
tape.

햹 Adjust, if necessary, either the
SMPTE output level on the Mac, or the
input level on your tape machine.

햺 When you are satisfied with the
levels, click the Stop Striping button
in the Stripe SMPTE Window.

햻 Choose Studio 5>SMPTE Reader
so that you can monitor the SMPTE
time.

햽 Turn off the Pause on your audio
recorder to begin recording. When
tape is rolling, click the Start
Striping button in the Stripe SMPTE
Window.
SMPTE time code stops generating
when it reaches the time specified in the
Stop field if the Stop check box is
checked.
If the Stop check box is unchecked, you
can click Stop Striping when you
reach the end of the tape.

햾 When you are finished striping, the
Studio 5Õs SMPTE/Power LED will
cease to flash. Click the close box to
close the Stripe SMPTE Window.
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Syncing to Tape
Once you have a tape with SMPTE striped
on it, you can use the Studio 5 to synchronize the Macintosh to the tape.
햲 Connect the SMPTE track output of
your multitrack tape recorder to the
Studio 5Õs SMPTE IN jack, as
discussed in Audio Connections
(pg. 13).

햳 Turn Jam Sync off by choosing Off
from the Stripe SMPTE WindowÕs
pop-up Level menu.

햴 Open the SMPTE Reader Window and
choose the MIDI Format that will be
sent used by your MIDI sequencer
(MTC, DTL, or DTLe).

햵 Put your tape machine into play
mode.
Verify that the SMPTE/Power LED is
flashing. When the Studio 5 detects valid
SMPTE code at its input, the SMPTE/
Power LED flashes and MIDI Time Code
(or, if selected, DTL or DTLe) is sent to
the computer.

햶 View the SMPTE time code in the
SMPTE Reader Window.

The Studio 5 performs an operation
known as “freewheeling.” If your multitrack tape has time code dropouts, the
Studio 5 will continue to send time code to
the Macintosh as if the signal were still
present at the input. If the Studio 5 loses
sync there could be one of a number of
problems. See Sync Problems (pg. 52) for
more information.
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SMPTE, Vision and the Studio 5
This section discusses syncing the
Studio 5 with Vision. The information is
also applicable to working with Studio
Vision.
햲 Launch OMS Setup and choose
Studio 5>Stripe SMPTE and
choose MIDI Time Code from the
MIDI Format pop-up menu.

sync source, and specify the desired
SMPTE frame rate.

햵 Select the desired playback sequence
and set its SMPTE Offset.

햶 Click Play in VisionÕs Control bar.
The play button will flash while Vision
waits for sync.

햷 Hit Play on your tape recorder and
Vision will start playing back in sync
with the tape.

Use a similar procedure for recording
tracks into Vision while synced to tape.
For more information concerning Vision’s
various sync modes, see your Vision
manual.
SMPTE, Performer and the Studio 5

Figure 6.12: Choose a MIDI Format

햳 Turn off Jam Sync by selecting Off
from the Stripe SMPTE WindowÕs
Level pop-up menu.

This section discusses syncing the
Studio 5 with Mark of the Unicorn’s
Performer.
햲 Launch OMS Setup and choose
Studio 5>Compatibility Setup.
Check the Emulate MIDI Time
Piece check box and set the View
pop-up menu to MIDI Time Piece
In.

Figure 6.13: Turn Jam Sync Off

햴 In Vision, set the sync mode to MIDI
Time Code, choose Studio 5 as the
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Figure 6.14: Setting the Compatibility
Window
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햳 Choose Studio 5 as an input source
for one of the cables.
It doesnÕt matter which cable you use for
the Studio 5 inputÑonly that one of the
cables lists the Studio 5 as an input.
Footswitch, time code and Audio In
events then appear to Performer as
having come from that cable.

햴 Choose Studio 5>Stripe SMPTE
and select MIDI Time Code from the
MIDI Format pop-up menu.

햵 Turn off Jam Sync by selecting Off
from the Level pop-up menu.

햶 Launch Performer and choose
Receive Sync from PerformerÕs
Basics menu and configure the
window as shown in Figure 6.15.

Performer is waiting to receive
external sync.

햹 Hit Play on your tape recorder and
Performer will begin to play back in
sync with the tape recorder.

NOTE: Unless your tape is at SMPTE time
0:00:00:00, it will be necessary to set a
SMPTE offset in Performer’s Counter window. See your Performer manual for
details.
NOTE: Performer may have difficulty handling time code, beat clock, active sensing
and note data all on one serial port. For
trouble-shooting tips, please see Sync Problems (pg. 52).

Figure 6.15: Performer’s Receive Sync
Window

햷 Choose Slave to External Sync
from PerformerÕs Basics menu to put
a check to the left of the option.
This causes PerformerÕs playback to be
locked to MTC.

햸 Hit the Play button in Performer. It
will be dimmed, indicating that
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You may connect more than one Studio 5
to a Macintosh. This is called networking.
You can connect up to six Studio 5’s to a
single Macintosh for a maximum of 1,440
MIDI channels.

When networking Studio 5’s, always connect the “B” port of the first Studio 5 to
the “A” port of the next Studio 5 (as
shown in Figure 7.1).

Studio 5 Numbering
NETWORKING BASICS
A network is defined as the connection of
one or more Studio 5’s to a Macintosh
serial port. The Macintosh has two serial
ports so it can support two networks. You
can connect up to six Studio 5’s to a single
Macintosh (two networks of three
Studio 5’s).

When you turn on a Studio 5, it displays a
number in the middle of its display for
about one second before it displays the
current patch number. This is indicates
Studio 5 unit number. Any Studio 5 connected directly to the Macintosh is
number 1. The Studio 5 networked to it is
number 2, and the Studio 5 furthest from
the Macintosh is number 3. Figure 7.2
illustrates Studio 5 numbering.

MACINTOSH

MACINTOSH

B

B
THRU

A

A
THRU

B

B
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A

A
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B
THRU
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Studio 5
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B
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A

A
THRU

Studio 5

B

B
THRU

A

A
THRU

Studio 5

B

B
THRU

A

A
THRU

One network of three
Studio 5Õs on the
Printer Port

Studio 5

Studio 5

Studio 5

One network of three
Studio 5Õs on the
Modem Port

Studio 5 #1

B

B
THRU

A

A
THRU

Studio 5 #2

B

B
THRU

A

A
THRU

Studio 5 #3

B

B
THRU

A

A
THRU

Studio 5
Studio 5
Studio 5

Figure 7.2: Numbering Studio 5’s

Figure 7.1: Two Networks of Three Studio 5’s
Each
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Changing Studio 5 Patches
When you change patches on one
Studio 5, the patches change on all
Studio 5’s in the network. Each Studio 5
contains the patches defined by your current Patch document.

MACINTOSH

B

B
THRU

A

A
THRU

B

B
THRU

A

A
THRU

B

B
THRU

A

A
THRU

Studio Setup Documents
Each Studio 5 has its own icon in the
Studio Setup document. If you have two
Studio 5’s, you’ll see two Studio 5 icons;
four Studio 5’s will produce four icons,
and so on. The names of the icons depend
on how you’ve connected the Studio 5’s to
the Macintosh.

NETWORKING OPTIONS
There are numerous ways to connect multiple Studio 5’s. The following sections
discuss your networking options.

Studio 5
Studio 5
Studio 5

One network of three
Studio 5's on the
Modem Port

Figure 7.3: One Network of Three Studio 5’s

Each Studio 5 has its own icon in the
Studio Setup document. The icon contains
the name of the serial port and the
number of the Studio 5. The network
shown in Figure 7.3 produces three
Studio 5 icons in the Studio Setup shown
in Figure 7.4.

One Network/One Cable
The first option is to connect all Studio 5’s
in a single network as shown in
Figure 7.3. You can connect no more than
three Studio 5’s in this fashion. The one
network/one cable connection gives you
the advantage of leaving a Macintosh
serial port free while still accessing up to
720 MIDI channels.
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Figure 7.4: Studio Setup Document for Figure 7.3

One Network/Two Cables, 4
Studio 5’s
The second option is to connect all
Studio 5’s in a single network and connect
a second cable between the last Studio 5’s
“B” port and the unused Macintosh serial
port as shown in Figure 7.5. You can con-
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nect no more than four Studio 5’s in this
fashion. This helps balance the MIDI data
stream between the two Mac serial ports.

duces four Studio 5 icons as shown in
Figure 7.6.

MACINTOSH

2nd cable connection
from last Studio 5 "B"
port to free Macintosh
serial port

B

B
THRU

A

A
THRU

B

B
THRU

A

A
THRU

B

B
THRU

A

A
THRU

B

B
THRU

A

A
THRU

Studio 5
Studio 5

Figure 7.6: Studio Setup Document for Figure 7.5

Studio 5

One Network/Two Cables, 3 Studio 5’s

Studio 5

If you have three Studio 5’s in a 2-cable
network, MIDI data distribution occurs as
follows:

Figure 7.5: One 2-cable Network of Four Studio 5’s

If you have four Studio 5’s in a 2-cable network as seen in Figure 7.5, MIDI data
distribution occurs as follows:
•

•

•

The Studio 5 connected directly to
the modem port will communicate
exclusively over that port.
The Studio 5 connected directly to
the printer port will communicate
exclusively over that port.
Studio 5 #2 communicates through
Studio 5 #1. Studio 5 #3 communicates through Studio 5 #4.

Each Studio 5 has its own icon in the
Studio Setup document. The icon indicates the number of the Studio 5 and the
fact that it’s part of a 2-cable connection.
The network shown in Figure 7.5 pro-
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•

•

•

The Studio 5 connected directly to
the modem port will communicate
exclusively over that port.
The Studio 5 connected directly to
the printer port will communicate
exclusively over that port.
The middle Studio 5 sends all of its
internally generated data (time code,
footswitches and foot controller info,
and Audio In note events) to the “B”
port connection and all other MIDI
data to the “A” port.

One Network/Two Cables, 2 Studio 5’s
If you have two Studio 5’s in a 2-cable network, then each Studio 5 communicates
exclusively with the Macintosh port to
which it is directly connected.
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three Studio 5 icons as shown in
Figure 7.8.

Two Networks
Your final networking option is to split
your Studio 5’s between both Macintosh
serial ports as shown in Figure 7.8. You
can connect up to three Studio 5’s on
either network. Using two networks gives
you complete control over which MIDI
data goes to which Macintosh serial port.
You must use two networks if you have
more than four Studio 5’s connected to a
Macintosh.

Figure 7.8: Studio Setup Document for Figure 7.7

MACINTOSH
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THRU

Studio 5

One network of one
Studio 5 on the Printer
Port

B

B
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A

A
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B

B
THRU

A

A
THRU

Studio 5
Studio 5

One network of two
Studio 5's on the
Modem Port

Figure 7.7: Two Studio 5 Networks

In this instance, each Studio 5 has its own
icon in the Studio Setup document. The
icon contains the name of the serial port
and the number of the Studio 5. The connection shown in Figure 7.7 produces
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THE STUDIO 5 MENU WITH
NETWORKS

SMPTE Reader

Any time the current Studio Setup document contains more than one Studio 5,
you’ll see them listed at the bottom of the
Studio 5 menu.

The SMPTE Reader displays the time
code received at the SMPTE IN jack of
the selected Studio 5. If you’re using multiple Studio 5’s, you must select a Studio 5
before opening the SMPTE Reader
window.

To select (check) a Studio 5, simply
choose it from the menu.

Stripe SMPTE Windows
The Stripe SMPTE Window works with
the selected Studio 5. If you’re using multiple Studio 5’s, you must select a Studio 5
before opening the Stripe SMPTE window.

Audio In
This toggles the Audio In feature ON or
OFF for the selected Studio 5.

Foot Controller In
This enables or disables the Foot Controller for the selected Studio 5.
Figure 7.9: Multiple Studio 5’s in the Studio 5
menu

The following sections discuss how each
Studio 5 menu item behaves when more
than one Studio 5 is present in a Studio
Setup document. See Chapter 8: Studio 5
Menu for a description of each menu item.
In general, you must select a Studio 5
before choosing a Studio 5 menu command. Windows that are already open
continue to work with the Studio 5 that
was selected when they were opened.
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Compatibility Setup
This command opens the Compatibility
Setup Window, which recognizes all
Studio 5’s in the setup document. If you’re
using multiple Studio 5’s, it doesn’t matter
which Studio 5 is selected when you open
the Compatibility Setup Window.
NOTE: If you use two Studio 5’s to emulate
four MIDI Time Pieces, you should use both
Macintosh serial ports. This gives you
access to 17 MTP cables on each port.
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Display ROM Version...
This command displays the ROM Version
for the selected Studio 5.

That Studio 5’s “B” port connects to the
second Studio 5’s “A” port.
MACINTOSH

FC1

FS1

FS2 AUDIO

Fast Mode Communication Speed

IN

OUT

13

B

This command dictates communication
speeds between the Macintosh and any
Studio 5’s that are connected directly to it.
Communication between Studio 5’s in a
network is always at a speed of 8 x MIDI.

MIDI IN
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FC1
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B
THRU

FS2 AUDIO
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A

B
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13
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9

8

7

MIDI OUT

Figure 7.10: One Network of Two Studio 5’s

Re-Establish Communication
This command re-establishes communication with all Studio 5’s regardless of
which is selected.

햲 Choose File>New Studio Setup
and search the Macintosh modem
port.
Your new Studio Setup document contains an icon for each Studio 5 in your
network (see Figure 7.11).

SIMPLE NETWORK EXAMPLE:
TWO STUDIO 5’S
You can network two Studio 5’s to a single
Macintosh using any of the methods discussed previously.
Figure 7.11: One Network/ One Cable

One Network/One Cable Example
Figure 7.10 shows a single network of two
Studio 5’s. The Macintosh modem port
connects to the first Studio 5’s “A” port.
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햳 Add devices to your Studio Setup
document and connect them to
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Connecting the Macintosh printer port to
the second Studio 5 increases MIDI
throughput capabilities by balancing the
MIDI data load between the two Macintosh serial ports. Studio 5 #1
communicates with the modem port and
Studio 5 #2 communicates with the
printer port.

Studio 5 icons to reflect the current
conditions in your studio.

Two Network Example
Figure 7.14 illustrates another possible
way to connect two Studio 5’s to the Macintosh. In this connection, all
communication with the top Studio 5 is
handled by the printer port, and all communication with the bottom Studio 5 is
handled by the modem port.
Figure 7.12: Sample Studio Setup Document
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One Network/Two Cable Example
MACINTOSH

You could add an additional cable
between the second Studio 5’s “B” port
and the Macintosh printer port (as shown
in Figure 7.13).
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Figure 7.14: Two Networks of One Studio 5 Each
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The only real advantage of the “one network/one cable” setup is that it leaves
you a free Macintosh serial port.
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Which Setup is Best?
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Figure 7.13: One 2-cable Network of Two
Studio 5’s
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2

1

The advantages and disadvantages of the
“one network/two cables” and “two network” options are more subtle. Each
Studio 5 can communicate directly with
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the computer without having to go “thru”
the other Studio 5. However, if you are
using a Studio Patch and want to route
data from a device on one Studio 5 to a
device on the other Studio 5, the one network/two cable setup is more efficient
because data can travel directly between
the two Studio 5’s. In the two network
setup, data must go from one Studio 5 to
the Macintosh and then to the other
Studio 5. In addition, the Macintosh will
only know that it must thru the data from
one serial port to another when OMS is
active. This means you cannot use this
type of patch with a two network setup
without the Macintosh being present.
With a one network/two cable setup, the
routing will work even if the Macintosh is
not present.
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Studio 5 Menu

THE STUDIO 5 MENU
The Studio 5 menu appears in the OMS
Setup application whenever a Studio 5
driver is installed and the current Studio
Setup document contains one or more
Studio 5’s.

Stripe SMPTE
Use this window to define SMPTE
attributes and to stripe tape with SMPTE
time code. It also determines the MIDI
format (MTC, DTL, DLTe) used by the
Macintosh. Stripe SMPTE Window
(pg. 31) discusses this window in detail.

Audio In
This enables the Studio 5’s audio-to-MIDI
conversion feature. Select this option to
enable it (checked). Select it again to disable it (unchecked). You can use Audio
In to sync Vision (or Studio Vision) to an
external audio signal. Audio In status is
saved in the Studio 5’s internal memory.
For a short tutorial, see Appendix A:
Using Audio In with Vision on page 49.
Figure 8.1: Studio 5 Menu

Foot Controller In
SMPTE Reader
This window reads the SMPTE time code
signal at the Studio 5’s SMPTE IN jack.
See SMPTE Reader Window (pg. 29) for a
detailed description of this window.
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This enables the Studio 5’s continuous
foot controller (FC1). Select this option to
enable the foot controller (checked).
Select it again to disable the foot controller (unchecked). Its status is saved in the
Studio 5’s internal memory.
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Compatibility Setup

Re-Establish Communication

This opens a configuration window in
which the Studio 5 can be set to emulate
either a standard 2 port MIDI interface or
a MIDI Time Piece. For details on using
this window, see Chapter 5: Using the
Studio 5 with Non-OMS MIDI Software.

On rare occasions, the Studio 5 may lose
contact with the Macintosh. This can be
caused by a lost MIDI message (due to
AppleTalk being on, for example) or a
software error within the Mac or Studio 5.
You won’t need to use this command
unless you see an alert message on the
Macintosh telling you that you need to reestablish communication.

Display ROM Version...
This will display the version numbers of
your Studio 5’s internal ROMs. You
should know your ROM versions if you
call Opcode Technical Support about your
Studio 5. Registered users will be notified
of ROM updates.

NOTE: To re-establish communication
from within most OMS compatible applications, choose the OMS MIDI Setup menu
item and click OK.

Fast Mode Communication
Speed...
Choose Fast Mode Communication
Speed to open a dialog for setting fast
mode communication speeds between the
Studio 5 and the Macintosh. This dialog is
discussed in detail in Chapter 4: Software
Setup.
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APPENDIX A: Using Audio In with Vision

This appendix discusses creating a tempo
track in Vision or Studio Vision using the
Studio 5’s Audio In capabilities.
Suppose that you have a live band
recorded on two tracks of a 4-track tape,
and that you’d like to supplement the
recording with some sequenced virtual
tracks. Follow this step-be-step procedure for using the Studio 5’s Audio In
feature with Vision.

begins a few seconds before the click
track you just recorded.

햵 Make sure that Studio 5>Audio In is
checked in the OMS Setup
application.

햶 Launch Vision and record enable the
TEMPO track of an empty sequence.
Click on the tempo number itself, so it
is selected.

햷 Set the record mode to ÒWait for
Note.Ó

햲 Make certain you have two blank tape
tracks. YouÕll need one for an audio
click track and one for SMPTE time
code.

햳 Record a click track onto a blank tape
track.
A rim shot or similarly percussive sound
works well. YouÕll want to include a one
or two bar count-off before the song
begins. The best way to do this is to turn
the tape backward (so when you play the
tape, you hear the music backwards),
and record the click track this way. When
the end of the song is reached, record an
additional two bars. When the tape is
played in the forward direction, youÕll
have two bars of clicks before the music
begins. The click level should be
between -2dB and +2dB.

햴 Record a SMPTE stripe on the
remaining track, making sure it
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햸 Set the sync mode to ÒInternal.Ó
햹 Play the beginning of the song. Use
the MacintoshÕs Òsingle quoteÓ (Ô) tap
tempo key to tap along with the song
to establish a rough tempo. This will
preset the sequence to about the right
tempo.

햺 Make sure Setups>MIDIKeys is
enabled.

햻 Make sure the Studio 5 is enabled in
VisionÕs Enable Input Device
dialog box.

햽 Open the MIDIKeys Window and
choose Add Line from its menu.
Highlight the new line and play a rim
shot or similarly percussive sound
into the Studio 5Õs Audio IN jack.
The Studio 5 sends a note (C#-1 or C#-2
on Channel 15, depending on the Middle
C setting in the Preferences).
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햾 Click the right side of the new line,
and type the single quote key (Õ). Your
MIDIKey is now set up as shown
below.

햳 Choose Edit>Delete Time. If there
was an event at 1.1.0, it will be
deleted. Now the tempo track should
correctly describe the tempos of the
click signal on the tape.

햴 Find the SMPTE time of the down beat
of bar one and set the Start Time (offset).

햿 Verify that the tempo track is still
record-enabled.

헀 Start the tape and listen to the
countoff go by.

헁 Play a MIDI note on the down beat of
the first bar of your song. This will
initiate recording of the tempo track.
The actual note will not be recorded.

헂 Let the song play through until the
end.

헃 Stop recording in Vision. Then stop
the tape.

In the List Edit Window of the tempo
track you will see one tempo change
event for every beat. This is the tempo
Vision has extracted from the click. It is,
however, one beat later than it should be:
each event is at the time it was recorded
(indicating the tempo of the past beat),
but needs to be moved to the beginning of
the beat (so the beat will play at the right
tempo). To correct this, you will have to
shift all the tempos one beat earlier:
햲 Set Òedit inÓ time in the upper left
corner of the tempo trackÕs List Edit
Window to 1.1.0, and the Òedit outÓ
time to one beat later.
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If you don’t know the SMPTE time of the
down beat, then set the sync mode to
“Time Code,” and turn off the Studio 5’s
Audio In feature in the Studio 5 menu.
Play the tape and watch the SMPTE numbers on Vision’s counter display. Set the
sequence’s Offset to a SMPTE number
five to ten seconds before the approximate down beat of bar one. Then, select
an empty track, rewind the tape, click on
Record, and start the tape. Listen to the
countoff and record a note on the down
beat of the first bar. Open the List
Window for that track, and look at the
absolute SMPTE time of the note you
recorded. Use this time as the actual
Offset for the sequence.
You may have to adjust the 80ths of a
frame of the Offset to make it exact—
especially if there is no specified offset
from the previous recording session.
Once you have a SMPTE Offset and the
tempo “map” in the tempo track of a
sequence, you can record and play
Vision’s MIDI tracks in sync with the
music on tape. You can copy the tempo
track and Offset to other sequences if you
wish to record several MIDI versions for
that tape recording.
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APPENDIX B: Troubleshooting

STUDIO 5 DISPLAY PROBLEMS

1

not enough memory in Studio 5 to
complete a command

Studio 5 displays a zero

2

memory management error

3

memory management error

4

a command parameter was out of
range

5

a command size was out of range

6

internal processor error

7

already executing another command

8

a Studio 5 serial port is busy

9

memory management error

10

Studio 5 received an undeÞned
command

12

memory test failed (memory not
valid)

13

power on failure

No patch is currently selected. Either the
Studio 5 is new, it has been reset, or you
have just deleted the current patch. As
new patches are defined in the Studio
Patches Editor, they are sent to the
Studio 5. Opening the current Patch document sends patch data to the Studio 5
automatically. Patch #0 is an empty, “do
nothing” patch.
If this doesn’t work, your battery may be
low. Contact Opcode for servicing.

Studio 5 displays a number
followed by a dash
When the Studio 5 encounters an error
condition, it will display an error message.
Error messages are recognized by a
minus sign preceded by a number. The
following is a list of Studio 5 error
messages:
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COMMUNICATION PROBLEMS
Macintosh loses communication
with Studio 5
From the OMS Setup application choose
Studio 5>Re-Establish Communication or, within any OMS-compatible
application, choose OMS MIDI Setup
and click OK.
If that doesn’t work, turn off the Studio 5.
Hold in both inc/dec buttons while turning the Studio 5 back on. This resets the
Studio 5 and empties its patch memory.
If the Studio 5 was turned off and then on
while OMS was running, the Mac will not
communicate with the Studio 5 again
until...
•
•

you open the OMS MIDI Setup
dialog and click OK or Cancel, or
you choose Studio 5>Re-Establish
Communication in OMS Setup.

You receive an Overrun Error
Message on the Macintosh
This message indicates that some information may have been lost by the
Macintosh serial port. Too much data is
being transmitted too quickly to the Mac.
Try thinning the MIDI data stream being
sent to the Mac. Refer to Studio 5 loses
sync (pg. 53) for various ways to thin the
MIDI data stream.
If thinning the data stream either doesn’t
help or isn’t possible, you will need to set
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a slower Studio 5->Macintosh communication speed. Lower the speed in single
step increments until the problem disappears, for more details see Setting a
Communication Speed (pg. 17).

PERIPHERAL PROBLEMS
Images on the Macintosh screen
appear distorted
The Studio 5 should be located at least 2
feet away from your computer monitor.

Unresponsive modems, initialized
printers, etc.
If the problem peripheral is connected
directly to the Mac’s serial port, you
should choose Edit>OMS MIDI Setup
from OMS Setup uncheck that port’s
check box, then click OK.
If the problem peripheral is connected to
the Studio 5, make sure the front panel
MIDI/Thru switch is set to the THRU
position.

SYNC PROBLEMS
Studio 5 will not stripe tape
Make sure the power cord is firmly
inserted into its connector, the power
switch is on, and that the SMPTE/Power
indicator light is lit.
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Check all cables between your computer
and the Studio 5, and between the
Studio 5 and your tape deck.
Check the input level to your tape deck.
Set levels as discussed in Guide to Setting
SMPTE Levels (pg. 33).

Studio 5 loses sync
Make sure that the heads on your tape
deck are clean and that your are using a
quality tape in good condition. Old or
worn tape may contain dropouts that
cause the Studio 5 to lose sync.
If you are syncing to tape, and your
sequencer keeps starting and stopping
erratically, you are probably losing sync.
One possibility is that your SMPTE
source is not good. This can be because
you have a bad tape or possibly a bad connection from your tape machine to the
Studio 5’s SMPTE IN jack. This is easy to
verify; if the Studio 5’s SMPTE indicator
light does not start blinking regularly
when you try to sync, the Studio 5 is not
getting a correct signal. Check your
cables and make sure that the recorded
SMPTE level is sufficient, see Guide to
Setting SMPTE Levels (pg. 33). If the tape
was recorded with too high a SMPTE
level, then it will have to be re-striped. If
SMPTE was recorded at too low a level,
you will need to boost the signal using a
preamp or mixer between your tape deck
and the Studio 5 SMPTE IN.
If the Studio 5’s SMPTE indicator light
blinks regularly, then a bad SMPTE
signal is not the problem. You may have
too much data going from the Studio 5
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into the Mac. Some instruments output
constant “active sensing” or MIDI clock
messages. MIDI clock messages especially can be a problem, because they are
sent more often than active sensing. Or,
you could have a device sending MIDI
Time Code. You don’t need this if you’re
trying to sync your sequencer to the
Studio 5’s MIDI Time Code. In general, if
you tell a real-time application (such as a
sequencer) to play, and then send it too
much data, it will start to lose some of the
data. If it loses time code data, it will lose
sync.
See if any MIDI devices attached to the
Studio 5 are transmitting data to the
Studio 5 (make sure none of them are
playing). Look at the red Studio 5 MIDI
IN LEDs. If any are lit or flashing, you
know those devices are constantly sending some kind of data. You can verify if
this is the cause of sync loss by turning off
or disconnecting the MIDI IN cables
(from the instrument into the Studio 5)
and seeing if the sync problem goes away.
If it does, you have a couple of choices:
•

If you can stop the device from sending this data in the first place, do it.
Unfortunately, some devices may not
let you do this. Typically, the devices
that send MIDI clocks have built in
sequencers; some of them only send
MIDI clocks when their sequencer is
actually playing. Others send MIDI
clock messages when they are in
their “sequencer” mode, and “active
sensing” (which is far less intrusive)
when they are not. If you cannot stop
the device from sending MIDI clocks,
you can set its sequencer to the slowest possible tempo—this results in a
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•

•

•
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slower MIDI clock transmission rate.
You can see the tempo change on the
Studio 5’s MIDI IN LED for that
device; it will blink slowly at slow tempos, and very rapidly at fast tempos.
You can slow down the Studio 5>Macintosh communication speed.
Decreasing the communication speed
will give the Macintosh more time to
“see” the incoming MIDI data, and
will help if the Macintosh is busy with
a lot of output as well as input.
If you’re using only one serial cable
between the Macintosh and the
Studio 5, try using two. OMS applications, such as Vision and Studio
Vision, will receive data generated
from within the Studio 5 out the
Studio 5’s “B” port. This includes time
code, Studio 5 footswitch and foot
controller data, as well as Audio In
note events. All other data coming
from MIDI devices connected to the
Studio 5 is received from the
Studio 5’s “A” port. If you are running
a non-OMS application, select
Studio 5>Compatibility Setup in
OMS Setup and select either Standard Interface In or MIDI Time Piece
In. Make sure that sync and only sync
is sent out the Studio 5’s “B” port (the
Auto button will also do this).
If you are running Vision or Studio
Vision, select Setups>Enable Input
Devices and only enable those input
devices from which you will receive
MIDI. If you have 15 devices, but you
only play one or two of them when
you record, disable all other inputs.

•

With Studio Patches you can design
Virtual Controllers to filter out MIDI
clock messages, active sensing, or
any other offensive data. You can
then use these Virtual Controllers
instead of the actual devices. In
Vision or Studio Vision, select Setups>Enable Input Devices, then
enable the Virtual Controllers and disable the actual devices on which they
are based. For non-OMS applications,
choose Studio 5>Compatibility
Setup, select either Standard Interface In or MIDI Time Piece In
views, then replace the unfiltered
devices with their corresponding Virtual Controllers.

Studio 5 will not sync to tape
Make sure the power cord is firmly
inserted into its connector, the power
switch is on, and that the SMPTE/Power
indicator light is lit.
Check all the cables between your computer and the Studio 5, and between the
Studio 5 and your tape deck.
Verify that the SMPTE/Power indicator
light blinks when it is receiving time code
from the tape deck. If not, you may have a
bad cable or connection between the
Studio 5 and your tape deck. Also, your
SMPTE level may be recorded too low. If
so, you may need to use a preamp or
mixer to boost the SMPTE level before
sending it to the Studio 5. See Guide to
Setting SMPTE Levels (pg. 33).
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Choose Studio 5>SMPTE Reader, then
start the tape. If it displays time code correctly, the problem is with your
application, not the Studio 5.

You may be using an Studio Patch that
references a Virtual Instrument containing a splitter routed to more than one
device on the same MIDI channel, or...

Sequencer gradually slows down
rather than stopping when synced
to a tape that has stopped

If you’re playing into a sequencer, you
should use an empty Studio Patch—the
MIDI Thru instrument is usually controlled by your sequencer (see Part 2:
OMS Patches), or...

Jam Sync mode is on. To turn off Jam
Sync, choose Studio 5>Stripe SMPTE,
and choose Off from the Level pop-up.

Audio In feature doesn’t function
Make sure the power cord is firmly
inserted into its connector, the power
switch is on, and that the SMPTE/Power
indicator light is lit.
Check the cable between your audio input
source and your Studio 5, and verify that
Studio 5>Audio In is enabled in OMS
Setup.
Make sure your software knows how to
interpret the Studio 5’s Audio In feature.

MIDI PROBLEMS
More than one instrument sounds
on a MIDI channel
You may be using an Studio Patch that
contains a splitter routed to more than
one device on the same MIDI channel,
or...
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If you’re playing into a sequencer, it’s possible that you’ve enabled both a virtual
controller and the “actual” controller as
input devices. If you’re in Vision, choose
Setups>Enable Input Devices and
make sure you only have one MIDI input
device enabled for the MIDI port used by
your MIDI controller, or...
In compatibility mode, you may have
“auto” enabled MIDI INs and OUTs, thus
causing some devices (particularly those
defined as multi-timbral) to sound on the
same channel as other multi-timbral
devices. There are only 16 channels available per port in a standard interface
emulation mode.

Incorrect system exclusive data
sent to Virtual Instruments
You shouldn’t send system exclusive data
to a Virtual Instrument consisting of two
or more MIDI channels from the same
device, or the sysex data will be sent
incorrectly.
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Difficulty receiving large system
exclusive data dumps
Reduce the Studio 5->Macintosh communication speed if you’re having difficulty
receiving large System Exclusive data
dumps. Reduce the speed in small increments until the data is received properly,
or...

MIDI data stream clogging
If you’re using Vision, choose Setups>Enable Input Devices and disable
any devices which is not recording into
the sequencer. Vision will ignore the data
from these devices, and more processing
power will be available for SMPTE sync
or dense MIDI data handling chores.

If you’re using Compatibility mode, make
sure that the Compatibility Setup Speed is
set to 1MHz.

Refer to Studio 5 loses sync (pg. 53) for
more ways to thin the MIDI data stream.

This problem is unlikely to occur unless
you have disabled the reporting of overrun errors since lost data is reported as an
overrun error.

Foot Controller doesn’t function
Check that the foot controller is connected to the proper connector (FC1),
and that Studio 5>Foot Controller In is
checked in OMS Setup.

Sound Designer II will not
communicate with some
samplers
The Studio 5 does not work with Sound
Designer II and samplers (such as E-mu’s
and the Prophet 2000) that communicate
using non-MIDI transfer rates. To use
Sound Designer II with these samplers,
you must use a standard MIDI interface.
Either:
•
•

56

Connect a standard MIDI interface to
an unused Macintosh serial port, or...
Connect a standard MIDI interface to
one of the Studio 5’s THRU ports,
then use the front panel MIDI/Thru
switch whenever you need to send
data between Sound Designer II and
a non-standard sampler.
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APPENDIX C: Specifications

General
•
•
•
•
•
•

Processors—68HC000 @ 16MHz, 68B03 @ 8MHz
Internal Memory—256k battery backed-up SRAM
Power Supply—120VAC, 60Hz @ 280mA or 240 VAC, 50Hz @ 180mA
External Dimensions (W x H x D)—44.45 x 8.64 x 28.02 cm (17.5” x 3.4” x 11.03”), 2
Rack Spaces (2U spaces)
Weight—2.99 kg
Operating Temperature—0°C to 32°C (32°F to 89.6°F)

Connectors
•
•
•
•
•
•
•
•

15 MIDI Inputs
15 MIDI Outputs
1 SMPTE Input—Stereo phone jack, Input Impedance: 500kW
1 SMPTE Output—Stereo phone jack, Output Impedance: <5W
2 Footswitch Inputs—Mono phone jack, Input Impedance: 10kW
1 Foot Controller Input—Mono phone Jack, Input Impedance: 100kW
2 Computer Ports—Serial, RS-422
2 Peripheral “Thru” Ports—Serial, RS-422

Display
3-digit LED Display (0-127)
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Switches
•
•
•

2 Patch Increment/Decrement switches
2 Peripheral “Thru” switches
1 Power on/off switch

Disclaimer
Specifications and appearance subject to change without notice.
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